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Introduction

Wily Technology’s Introscope is a proven solution for live performance monitoring of real end-user transactions within Web Applications.  The patented Introscope Agent technology resides inside the Web Application Server and monitors live transactions as they occur within the Web Application.  In today’s world of complex Web Applications, this is the preferred approach for Application Performance Monitoring and Management as it guarantees that the performance data corresponds to real user interactions with the system.
However, there may be situations in which it is helpful to be able to monitor “Synthetic Transactions”, that is simulated transactions that are not associated with any real user, but are initiated to test the availability and performance of a system at certain times.  For example, synthetic transactions may be useful in a situation in which a Web Application gets no activity during part of the day, and yet it is important to continuously assess the application’s performance and availability.  In lieu of having any real user transactions to monitor, synthetic transactions can be sent to the Web Application.  The performance and availability of these synthetic transactions is then used as a gauge of the performance and availability of the web application.  In this case the performance of the synthetic transactions is used as an approximation for the performance of any real user transactions if there were any.
For a customer that is already using Introscope for live production performance monitoring of real user transactions, synthetic transactions can easily be added and monitored utilizing a combination of the Apache JMeter testing tool and a JMeter “Listener” built especially for Introscope integration.  This document describes a possible architecture for such an implementation and discusses the Introscope JMeter Integration.
Architecture Overview

The architecture discussed in this paper is made up of three primary components:  A Web Application to be Managed/Monitored;  An installed Introscope application management system;  and the JMeter Synthetic Transaction Engines.
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Web Application

The current discussion is pertinent to monitoring Web Applications; therefore it is important that there be a Web Application to monitor.  In this case, “Web Application” means any application that has a user interface that is accessed through a Web Browser.  This could be an internal application, an extranet application, or a customer-facing Internet application.
Introscope Application Management
An installed Introscope system is assumed for this discussion.  The Introscope application performance management system consists of one or many Introscope Performance Monitoring Agents, the Introscope Enterprise Manager, and one or more Introscope Workstation or Introscope WebView client applications.  

Introscope Performance Monitoring Agents:

Introscope Agents can come in many flavors.  The Introscope Agent for Java is the core Introscope technology that monitors the performance of the internals of Java and J2EE applications.  In addition, other Agents can gather data from other systems outside the Java AppServer for correlation within the Enterprise Manager.  The Introscope EPAgent system provides a number of different monitoring Agents.  For this discussion, the WilyJMeterIF is an Agent integration directly with the Apache JMeter testing tool.  This integration embeds an Agent directly into JMeter which allows the performance monitoring of synthetic JMeter transactions.
Introscope Enterprise Manager:

The Introscope Enterprise Manager (EM) is the hub of the Introscope performance management system.  The EM gathers the performance data from all of the reporting Agents and correlates, aggregates, stores, and manages this performance data.

Introscope Workstation/WebView:

The Introscope Workstation (and it’s thin-client, browser-based counterpart, WebView) is the User Interface into the Introscope data.  Intuitive and graphical displays present the application performance data in a manner that is easy to use and understand.

JMeter Synthetic Transaction Engines

As mentioned above, one mechanism for obtaining application performance and availability data (other than monitoring real user transactions with Introscope) is to initiate simulated or synthetic transactions against the Web Application and monitor their response and performance.  
Synthetic transactions can be initiated with the Apache JMeter testing tool, and with the WilyJMeterIF Agent integration installed, the response times and other performance stats of these synthetic transactions can be sent directly into the Introscope Enterprise manager for correlation with other application performance data.

This architecture requires one or more installations of the Apache JMeter testing tool.  This JMeter installation can be easily configured with a test script that initiates synthetic transactions against as many of the key application transactions and/or interactions as desired.  Likewise, JMeter can be configured to initiate the synthetic transactions as frequently or as infrequently as needed.  More information on configuring JMeter is below.
Managing Large Installations

In an architecture in which many JMeter engines are deployed to simulate transactions from multiple geographies or points-of-presence, it may be desirable to manage the deployment of these JMeter instances with an enterprise change management solution such as Altiris or Zenworks.  

To deploy scripts and manage multiple JMeter instances, JMeter, itself, supports remote management for multiple instances from a single client.  See “Remote Servers” below.
In large installations many scripts may need to be parameterized for environments where user credentials or other parameters need to be modified over time or be tailored for specific locations.  JMeter is very flexible, and can be used in just such an environment.  JMeter provides for reading those variables from a file or from a Servlet or even a web service.  Using this method the script would read the file, Servlet, or service and have the parameters replaced dynamically.  This way the values can be refreshed periodically without the need to modify and redistribute your test scripts. An example of setting up parameters in JMeter follows:

1. Add Pre Processors > User Parameters to Thread Group 

a. Click Add Variable 

b. Set Update once per iteration 

c. Set the Name to the name of the variable (e.g. ACCOUNTID) 

d. Set the value (under User_1) to ${_StringFromFile(accounts.dat)} 

2. Add Sampler > HTTP Request to Thread Group: 

a. Click the Add button to add a parameter to the request: 

b. Name: account_id 

c. Value: ${ACCOUNTID} 

3. Create the file accounts.dat containing one line per account id. 
[In the bin directory, unless you add a path to the parameter to _StringFromFile] 

In each iteration the ACCOUNTID variable will be set to the next line in the file, and the HTTP Request will use its value to set the account_id parameter. 

WilyJMeterIF - A JMeter Interface for Wily Introscope. 

WilyJMeterIF provides a Jmeter Listener that can be added to test plans in JMeter for reporting results of round-trip user URL response times into the Introscope application management platform.   The WilyJMeterIF Jmeter Listener will serve as an Introscope Agent and report Jmeter Metrics to the Introscope Enterprise Manager.  It will record the results of each thread in a Jmeter test plan under separate nodes in the Introscope Workstation Explorer tree with subnodes and corresponding metrics for each sample (i.e., HTML request) executed.   Following are the metrics recorded for each sample:

· Execution Response Time (ms)   

· Reponses Per Second

· Counts of each response code returned (404's, 200's, etc.).

Versions Supported:

· JMeter 1.9.1 thru 2.3.4 ( as of this writing )
Installation:
Assumptions:  JMeter & Introscope are both installed

1. Unzip WilyJMeterIF.zip in the root directory of Jmeter.   
This will install WilyJMeter.jar, Agent.jar, and ProbeBuilder.jar into <jmeter_home>/lib/ext and create <jmeter_home>/bin/wily with a few resources.

2. Edit <jmeter_home>/bin/wily/IntroscopeAgent.profile to set the host and port number for the Introscope Enterprise Manager.
3. Once installed, add a "Wily Listener" to a test plan through the Jmeter GUI in the same manner as any other Jmeter listener.   Test results can optionally be written to a datafile for validation purposes.

Note:  The above assumes a Windows platform.   For unix, unzip the WilyJMeterIF.zip file on Windows and copy the jar files to the unix directories which correspond to the above.
To Run:

Assumptions:  Introscope Enterprise Manager and Workstation are running
1. Run JMeter.  Under windows this is done with <jmeter_home>/bin/jmeter.bat.

2. Create a test plan (or load the sample) and execute.   A sample test plan can be found at <jmeter_home>/bin/wily/Wily Sample Test Plan.jmx.

JMeter Configuration
	The following section from the JMeter user guide describes the process for creating a simple monitor test plan to check the response time of a monitoring Servlet.  Similar Servlets exist in Websphere and Weblogic.  Checking these monitoring Servlets verifies that the application server is functioning properly and do not alter business data such as inventory or balances.

	


	11.1 Adding A Server 

	The first step is to add a Thread Group element. The Thread Group tells JMeter the number of threads you want. Always use 1, since we are using JMeter as a monitor. This is very important for those not familiar with server monitors. As a general rule, using multiple threads for a single server is bad and can create significant stress.

Go ahead and add the ThreadGroup element by first selecting the Test Plan, clicking your right mouse button to get the Add menu, and then select Add --> ThreadGroup.

You should now see the Thread Group element under Test Plan. If you do not see the element, "expand" the Test Plan tree by clicking on the Test Plan element.
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Figure 10.1. Thread Group with Default Values 
Enter the name of the server.

	


	11.2 HTTP Auth Manager 

	Add the HTTP Authorization Manager to the Thread Group element (Add --> Config element --> HTTP Authorization Manager). Enter the username and password for your webserver. Important note: the monitor only works with Tomcat5 build 5.0.19 and newer. For instructions on how to setup Tomcat, please refer to tomcat 5 documentation.

	


	11.3 Adding HTTP Request 

	Add the HTTP Request to the Thread Group element (Add --> Sampler --> HTTP Request). Then, select the HTTP Request element in the tree and edit the following properties):

1. Change the Name field to "Server Status".

2. Enter the IP address or Hostname

3. Enter the port number

4. Set the Path field to "/manager/status" if you're using Tomcat.

5. Add a request parameter named "XML" in uppercase. Give it a value of "true" in lowercase.

6. Check "Use as Monitor" at the bottom of the sampler

	


	11.4 Adding Constant Timer 

	Add a timer to this thread group (Add --> Timer --> Constant Timer). Enter 5000 milliseconds in the "Thread Delay" box. In general, using intervals shorter than 5 seconds will add stress to your server. Find out what is an acceptable interval before you deploy the monitor in your production environment.

	


	11.5 Adding a Wily Listener to Store the Results 

	If you want to keep a record of the server's performance, add a Wily Listener. This element is responsible for sending the results of your HTTP requests to an Enterprise Manager.  These metrics can then be used to fire alerts when response times are exceeded.

	


	11.6 Adding Monitor Results 

	Add the Wily Listener by selecting the test plan element (Add --> Wily Listener -- > Monitor Results). There are two tabs in the monitor results listener. The first is the "Health", which displays the status of the last sample the monitor received. The second tab is "Performance", which shows a historical view of the server's performance.




	11.7 Saving the Test Plan 

	Although it is not required, we recommend that you save the Test Plan to a file before running it. To save the Test Plan, select Save Test Plan from the File menu (with the latest release, it is no longer necessary to select the Test Plan element first).

JMeter allows you to save the entire Test Plan tree or only a portion of it. To save only the elements located in a particular "branch" of the Test Plan tree, select the Test Plan element in the tree from which to start the "branch", and then click your right mouse button to access the Save As menu item. Alternatively, select the appropriate Test Plan element and then select Save As from the Edit menu.



	


	11.8 Running the Test Plan 

	From the Run menu, select Run.

JMeter lights up a green square in the upper-right-hand corner to indicate if a test is currently running. The square is turned gray when all tests stop. Even after you select "stop", the green light will stay on until all test threads have exited.

Once JMeter has finished running your Test Plan, select Stop from the Run menu.

If you selected a file to save the results to in your listener, then you will have a file that can be opened in any visualizer. Each visualizer will display the results in it's own fashion.

It is possible to have the same file open in more than one visualizer. This is not a problem. JMeter will ensure during the test run that no sample is recorded to the same file more than once.



	


	12.1  Remote JMeter Servers 

	An option exists to control multiple, remote JMeter engines from a single JMeter GUI client. By running JMeter remotely, you can replicate a test across many low-end computers and thus simulate a larger load on the server. One instance of the JMeter GUI client can control any number of remote JMeter instances, and collect all the data from them. This offers the following features:

· True performance measurement without network bottlenecks

· Fast responsive GUI

· Saving of test samples to a local machine

· Management of multiple JMeterEngines from a single machine

Note that while you can indeed execute the JMeterEngine on your application server, you need to be mindful of the fact that this will be adding processing overhead on the application server and thus your testing results will be somewhat tainted. The recommended approach is to have one or more machines on the same Ethernet segment as your application server that you configure to run the JMeter Engine. This will minimize the impact of the network on the test results without impacting the performance of the application serer itself.

	


Step 1: Start the servers 
To run JMeter in remote node, start the JMeter server component on all machines you wish to run on by running the JMETER_HOME/bin/jmeter-server (unix) or JMETER_HOME/bin/jmeter-server.bat (windows) script.

Step 2: Add the server IP to your client's Properties File 
Edit the properties file on the controlling JMeter machine . In /bin/jmeter.properties, find the property named, "remote_hosts", and add the value of your running JMeter server's IP address. Multiple such servers can be added, comma-delimited.

Note that you can also use the -J command line option to specify the remote host(s) to use. E.g. jmeter -Jremote_hosts=host1,127.0.0.1,host2

Step 3: Start the JMeter Client 
Now you are ready to start the controlling JMeter client. For MS-Windows, start the client with the script "bin/jmeter.bat". For UNIX, use the script "bin/jmeter". You will notice that the Run menu contains two new sub-menus: "Remote Start" and "Remote Stop" (see figure 1). These menus contain the client that you set in the properties file. Use the remote start and stop instead of the normal JMeter start and stop menu items.
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Figure 1 - Run Menu
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